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��" ���������" �����!��� �������"#�� MLC �����' ���" ���������(� �����$��� MT 
(notebook), ��� ��"���� � ���, !�� � '���������� �� !��� ��� �� MLC ��)�����" ��� ��, 
��� � �����$��� MN. *����� �����, ���')����� MT ����%�� �������� ���, ��� ��� 
������� � ��� ����� �����, ����� !��� ������ IP-������ � ��%������������ ����. 
*����!��" �������"#�" ����( CDG �������" ������ � ��� �� !��, ���� ��� 
����������� ���, ����  ������ � ���������(� ������� ���"���� �����" %����. ��" 
������  �������"#�� ������������ ������ � ����() �� ��� �� MLC ���')����� �� MT 
�������������� �������� $ �����$ ���������" MN, ����������� ����(� ��" 
�������"#�� � �������� %���( ��"  PPP-���������". 
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1. ���
�
��� 
�������� MT 

+ ���$ Start -> Settings -> Control Panel -> Network and Dial-Up Connections �('����� 
Local Area Connection. + ���� Local Area Connection Properties �('����� Internet Protocol 
(TPC/IP) � ������� �����  Properties. ,�������" ����� ���� Internet Protocol (TCP/IP) 
Properties, � ������� ������� IP-����� ��������� MT, ����  Subnet Mask � ��$� �� 
 ���!���$ Default Gateway. *���������� ���� �������� ������ Apply � �(������� 
������� �� (restart) �����$���� (����   ��� �����#�����" ������� WIN 2000 
Server/Professional – �� ����� ������ �� � ���). 

 

                  
 
+ %��� Hosts, ��)��"-���" � ���������� C:\Winnt\system32\drivers\etc\Hosts ������� IP-
����� � ��"  ���, �����(� ' ���� ��������������, � ����� IP-����� ������� MT 
(���#�� �  ��������� �� ������� MN). 
 



 ��������� 
��	
������  

 

�: 
85/2004 

 

�����: 
���	� 	
��
� 

����: 
20.10.2004  

 

���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 

 
5/34 

Obr.:77-098a 
 

 
 

��" ������ $-�) �������� ���')����� �������, ���%�� ��������� ������� 
���')����� �(������� � ������������ �� ���� $-�� ������������������$. ,������� 
Start -> Programs -> Communications -> Hyperterminal -> Hyper terminal. +������ ��" 
�������, ����� !��� � ����(�����" ���� ������� �('����� File -> Properties.  
 

   
 
+ ���� Properties �('����� COM1 � ������� Configure  ��������� ���� $-�� ��������( 
� ��� ���"���, ��� ��� ������������: 9600  /  8  /  None  /  1  /  None. 
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2. ��
� IP-�����
� 

��" ���� IP-������� ��� ����� ��������  Hyper terminal, ��������� ���� COM1 
�����$���� � ���� RS-232 ����( CDG � ����-�$ ��'��" ������� � ���$!��� ��� �� 
MLC �(��$!������, �����������(� �� '���� ������" PLC. ,'������ ��"�����" 
��!������ ������ � ������� �$' $ �����  ������� �( �� '����, !�� �� ��� ��� ��(.  
 
MASTER loading side 
Attaching to ATA disk device... 
File system checking... done 
 
Eth. interface : eth1 
IP address     : 192.16.38.2 
Subnet mask    : 255.255.255.0 
Default gateway: 192.16.38.1 
---------------------------------- 
Package dir    : /ata/ 
Boot device    : DISK 
Max. loading   : 5 
Startup delay  : 3 sec. 
 
Press any key to stop auto-boot... 
 3 
Attaching network interface, wait ... 
Attaching network interface lo0... done. 
Attached TCP/IP interface to eth1. 
Hard disk found 
Free disk .......... 244.7 MB (99% of 244.7 MB) 
Active directory ... /ata/ 
 
Type "help" for help or "run" to load application. 
 
[Boot]: 
 
.� ������� ��"����"  [Boot]: ��� ����!���, !�� ��� �� ��)�����" � ������ “Installation 
State”. 
������� ipconf ��� ����� ���#�� �   �������� �����%���� ethernet ��" 
�������������" � ���������� MT. *�  ���!���$ �����%��� ethernet - eth1, 
���������!�� ��" �����$!���" IP-�'�������.  
 

��������: $ � '#$( )����� ( MN/M
 ���*$� ��'# +,%���� ethernet-�����-�.� eth2 
(�� ���%�(� ��&� #/#,����� /%(�#. A, �� ' ��� CDG ���'# #&�� �#��# ����0%).  
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���%�#( 1. �0�"� "�������(#. ' ��1  CDG � #��#��2�0�� ( ��. �����-�.�#�. 
 

[Boot]: ipconf 
 
'.' = clear field;  '-' = go to previous field;  ^D = quit 
 
Eth. interface num. [1]   : 2                <!!*�- * 2 �)/ (0 #$�!"- -$ *45*30# eth2> 
IP address [192.16.38.2] : 192.168.38.28 < !!*�- * IP-#�4*0 - *45*30# eth2 > 
Netmask [255.255.255.0]       : 255.255.255.0 < !!*�- * '#0"( subnet - *45*30# eth2 > 
Default gateway [192.16.38.1] : 192.168.38.1  < !!*�- * 6)+2 1� ('�),#$-+> 
Network interface is allready attached, change IP address 
ifAddrSet failed, errno = S_errno_ENXIO (0x6) 
Failed to attach network interface! 
 
Warning: Ethernet interface number is changed. Reset to apply changes. 
[Boot]: 
 
*��������(� �(�� IP-������ �������( �������!����, ������, ��" � -���� $-��� 
�'/����, �� ������� ��� �� MLC ��)�����" %����!����, ��� ���������( �������� 
�������. *� ����!���$  �������� �����%���� eth2 ��" ��������#�� �������() ����() 
���')����� ���������� �������� ��  ��� �". &������� ��� � ����-�$ ������( reset. + 
��"�� � ���, !�� ��� �� LA5052 ����� '(�� � � '���������� ���������� (��� ����( 
CLC), � #���$ ���������"  ��������" � �������" � '���������� ������( ���')����� 
 ��������� �����%��� eth2 � �� ����� CDG, ��)��"-���" �� � '���������� ����� CLC. 
*��#�� ��  �������� �����%���� eth2 �� ����� CDG, ��)��"-���" �� � '���������� 
����� CLC, ��������$ ������!�� ���#�� ��, ��������� �(��. . ��� ���� ����������� 
��'��� ������� �� ���� $ ����  CDG � ���#�� �  ���������. .��')����� �������, !�� 
�����%���  eth2 �� ������ ����� CDG ���')����� �('���� �� ��� IP-�����, ����!�(� 
�� IP-������ �����%���� eth2,  ������������� ����� �� ������ ����� CDG. 
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���%�#( 2. �0�"� '#$( )����� ( MN/MT '�� '# �#��+)  #/#�%$#����#" "#$% �. 
 

��������: �����-�.� Eth2 $ � �,��"#$�.����� � MN/MT ��0#$���� ��  ' ��� 
MASTER CDG, ,���"�)2�. $#����))  '#,�!�)  PMC0. �����-�.� Eth2, 
��0#$�2�.�� �� ' ��� SLAVE CDG, ,���"�)2�. $#����))  '#,�!�)  PMC1, �� 
��'# +,%����  � �*# (#�-�*%���#����� �� '�#�,�#$����.    
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3. 	
���
��
�����  	�34 -����� 

*���� ������ �������"#��� ����������� %������������� %���-�����. ��" ����� 
��������� ������  format � ������������ �� ���� $-�� ���#�� ���: 
 
[Boot]: format /ata 
Do you realy want to initialize /ata disk?  
All data will be destroyed! [y/n] y  <1�� !*4�- * $#7# -*' y> 
[Boot]: 

4. ���
�
��
�
 �
 ����
�� ��
5������
����6 	�34 -����
�      
���
7  CDG  


����" ����� CDG �� �'/���� ������ ����� ������(� �����!�(� '��� %��� (VxWorks), 
�������� $ ���� ���� $ �����$ ��������( %��� �� %���-���"�� � ��������� 
�������(� IP-�����, ����������(� ��������. �� ��������� ���������������� 
���������" ������ � ��� �� !��, ���� ���"���� �����" %����. +������ � ������  MN � 
��!����� �����������" mnadmin � ��� ����� ��������  TFTP. *�������� ����!�� 
 �������� TFTP �� ���������� c:/flash, � �� �������������� '(� ��)����� ����!�(� 
%���. *����� ����� ��� ���')����� ��������� �� ���� (��� � '���������� ������� - �� 
�'� �����) ��� �" ���� ��. ���� �� ����� CDG �-� ���$!�� �����!�(� '��� %���, �� 
������  ���� ����" pSOS pSH+>. + ���� �� !�� ������$!����� ST4 ���')����� 
��������� � ���������, ���������� ����.  
 
            ST4             
 
            ST3         
 
 

 
 

���%�#( 3.   �'��� ���� - 89-'�"��+)  �� ' ��� CDG 

*����!� +����!�. *�����$!���� ����  '������ 
  0��o��� ���" � ��o���o����� 
����(�� ����(�� 1���(��� �����!���� '���� 
����(�� ����(�� 1���(��� �����!���� '���� 
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& ����-�$ ������$!����" ST4/1 �����������" ������ '����� %��� ����  ��'��, � �� 
����" ��� � ����-�$ ������$!������ ST3/1 � ST3/2 ��� ����(��$��" (��������� OFF) 
� ����(��$��" (��������� ON). *�����$!����� ST4/2 ��" ����������� ������ ��'��( 
������ ��)�����" � ��������� OFF! ���� �����!�(� %��� � ���#���� 
���������������" ��� �-� ����(�, �� ������ ������� ��"����" ������: 
 
Erasing flash at 0xfff00000 ... failed  
Erasing flash: error (address = 0xfff00000 (sector 56), status = 0x41  
Low VPP error  
Erase error  
Failed to reprogram flash  
 
.� ���� ��� �" ���������� ���������� $-�� %��� ��" ���������������" %����. 
&�������� ������ ������� ���� $-��: get <src_file> [<dest_file>] [-f | -t <serverIP>]. 
���� <dest_file> �� ���������, ��������" %��� � ������ <src_file>. 
�������  set tftp ip 
<IPaddr>  ��������� ������ TFTP. &���  ����� '(��  ��������� ������ ���� ������ 
TFTP, ������������� ��  ��������, �����������" ��������� ��������. 
 
#'�#�"#�� %����#�#( TFTP  
[Boot]: set tftp  
Default TFTP server: 10.1.2.115  
 
#%����#�(� ������� TFTP '# %"# ����)   
[Boot]: set tftp ip 192.168.38.90  
 
#'����#� -�. �  
[Boot]: get MVVK0A02.bin 
401472 bytes transfered  
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���%�#( 4.  
(�# '�#*��""1  TFTP Server95 
 

������ flash ������� ���" ��" �����( �������"#������ ��������( � �����!��� ��� 
�����!��� '���� %���. ,'����!����� ����������������, ���� ����!�(� %���  �� ���� 
�� �����. *����������� �'"�������� ������ �����, � ����� ������� ��������" ���, 
��)������(� � %����, �.�. ���������������� �� ����������(� ����� (��� � ����-�$ 
������������� %����) ����� ��������� ���� . &������� ������( ���� $-��: flash 
<addr> <file> [ -f | -t [<IP>]].  
 
[Boot]: flash fff00000 MVVK0A02.bin 
Destination address ... 0xfff00000  
File size ............. 401472 bytes  
Do you want to rewrite flash (y/n)?y  
Erasing flash at 0xfff00000 ... done  
Erasing flash at 0xfff20000 ... done  
Erasing flash at 0xfff40000 ... done  
Erasing flash at 0xfff60000 ... done  
Writing flash at 0xfff00000 ... done  
Writing flash at 0xfff20000 ... done  
Writing flash at 0xfff40000 ... done  
Writing flash at 0xfff60000 ... done  
Flash is successfuly reprogrammed  

 
��������: /%$+�� ���"��� +�1  � �$����"� ('���� +�1. �$��� - fff00000), 
#/��2�.�� ���"���� �� ��,"��1  -�. #�. ��� ��#$� ��'���� +�10 $���10 
� � '�� '#�� ���� '�#/ �" '�� '����#��, '�#*��""��#����� - 89-'�"��� 
�#,"#&�# '�#�,����� '#���$���#" ���9��*# "�0���,"�.  
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��� ���������" � ���������� %����. &��.: 
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5. ������ ���
������� ��
5�����
5
 ����
� � ����7 : �� 
�
���� �; 
�������� MT 

+ ���� Management Login ������� New � �('����� ���� �� ��� ���(, ���������� $-�� 
��� �$ MLC (LA5052AX), �����(� ���')����� ��������������. + ������ �� !�� ���  
LNLW0A04 / MVSA0A03 / PBKB0A03 / PBKC0A03 (��� ���������� ������� ������) 
������ ��������� #�%�(  ����!���$��"). 
 

 
 

������ Accept �('����� ���')���� $ �����$, ����� !��� ��������" ���� System 
Management. 1���� � ����-�$ ������ Insert �������� ���� Node Data – Insert.  
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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+ ���� ���� � ��� ����� ����� ��� �" (�������� Node), � ������ �� !�� – 2002, � 
����� ��� ������( (�������� Duplicated), � ������ �� !�� - Yes. *��� �� LA5052 
������������ ��� ��� '�������� $, ��� � � '�������� $ ������ , ������  � ��� 
�('���� «No» ��� «Yes». ����� ���� �� �������� Node Name, �����(� ����� '(�� 
�$'(�, � Hostname, �����(� ������ '(�� ������!�� ������ � %���� Hosts. 2���� 
 ���"� �(� ��������(  �� �������� ���������(. 0�'����� ����� ���������� $-�� 
�������� � ���� Type, �����(� ����� '(�� «Access Node», «Access Node – 1U» ��� 
«Access Node – Shelter». 3�� «Access Node» ������� ���" � �� !�� ��� �" MLC, �� 
������� �������� ���%�� ��#�" 22-) �'��������) ����. 3�� «Access Node – 1U» 
������� ���" � �� !�� ���������" ������ ����� ����( CLC, ������������� � ���� �� 
1U. 3�� «Access Node – Shelter» ������� ���" � ��� �� !��, ����� ���� ���� �� 
���%�� ��#�" ���"�� �'��������) ����. + ���� Hardware Type �('����� ��� ��������() 
�������, �.�. «FULL», «COMPACT» ��� «1U». 4��� �������� ������ ��������� � ����� 
�('����(� ���������� Type. + ���� Connection Type �('����� �����' �������" � 
 ��������" ��� ��� MLC. *��  ��������� � �������� !���� ���� ethernet ����������� 
��������� PPP �('����� «Local», ��� ������������� ��������� ���������" – ����� 
«Remote». ��" � '���������� ������( ���� ���� $� ��������( A Side Hostname � B 
Side Hostname, ��" �����() ���')����� ������ ����� ������ ������(.  ,��������� 
��#�$ Default Data � ����������� ������� Accept. *�"����" ���'-���� � ���, !�� � 
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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%��� Hosts ���')����� ������ Hostname, � � �� !�� ��������������� ��#����� ����� 
���'-���� � �� �'"�����������.  

 

       
 

��������: ��#$%(� LA5052 ���/%�� �#�#.  �!��,��, ��'#���$������# 
#��#��2�.�� ( �#"��% %, � � ��'% �����"1  (��$%/ ��#������/$%/ ��#������). 
�#&�# ������ �# +(# �� �#"��� %, #�, (#�#�1� ��,��9��1   �!��,��.. 
 

+ ���� System Management ��"����" ������ ����������  ���. *���������� �������� 
Apply. 3����� ��"����" ���� RestartNet, ������� �� ����!���$ �'��'���� (Done) 
����������� �������� OK. 

 
+ ���� System Management �(������� ������� ����() ��  ���!���$ (Default Data). 
+('����� � ���$ Administration -> Database -> Node Data -> Export. 
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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*���� ������" ������ Run � ������������" ������� �� ����������� ���#�� �(, 
������� ������ ��, ��!����" ������� ����() ��  ���!���$. 

 

          
 

����(�, ��� !���(� �� �������"��" Iskratel �� ������� ��� �� CD, (� ������ �� !�� ��� 
���������� VOIP2002) ������ ��� � ��'�!�� ���������� ���� ��� LA5052AX. + 
���������� ��)��"��" ��� ������������" unl � rtdb, �� �����() ��)��"��"  
�������������� ������������(� ����(� ��" ����������� �'/����. 
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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.��(� ����(� �������� ��� � '��  ����(). 4�� �(����"���" � ����-�$ ��'��� ������ 
���� System Management , � ������� �('����� Administration -> Database-> Node Data -> 
Import � � ���� Import Node Data �('����� ����������, �����������(� � ������( ��� � 
CD. 
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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*���� ������" ������ Run � ������������" ������� �� ����������� ���#�� �(, 
������� ������ ��, ��!����" ������ ������������() ����� ����(). 
 

 

      
 

*���� ������� ������������() ����� ����() �(������� ����� �) �������. 4�� 
���#�� �� ����'�� ���#�� ��, �(����"���� ��� �������� ����() ��  ���!���$, � ��� 
���� �����#��, !�� ������ �������  ���� ���� ��", ��������� $-�� ���� ��� 
�(�������" (��������, 14_09_2002). *���� �(�������" �������/�������� ����() 
�(������� ���%�� ��������� ethernet-�����%�����, ������� IP-������ ��" ethernet-
�����%�����, � ����� ��" � IP-����� MN, �� �������� ' � � �(����"���" ��'��( � 
�������� �'/����. ,������� ���� Configuration Management, �('����� ������(� �'/��� 
�  ��������� ��� � ����� ��'��( Read/Write (���$ Mode & Seizure -> Set Mode & Select 
Node). .��')�����  ���"� �� ��� �� � ��, !�� ����(, �����(� ����� ' � � 
���%�� ���������" � �������������", �����( '(�� ����-���(��. 4�� �(����"���" � 
���� Global -> HW Configuration -> Port -> Global , ��� �������� �� ��� ��� ����.  
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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,�������" ����� ���� Port Configuration. 
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20.10.2004  

 

���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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+ ���$ Configuration  -> Ethernet Configuration �('����� ��#�$ Port.  
 

 
 
,�������" ���� Ethernet Port ��" ���%�� ��������" ethernet-������. 
 

 
 
+('����� ���')����(� ����, �����(� ' ��� �������������" ��" ����������������" � 
 ��������" ��� ��� !���� ethernet-���������� ��� ��" �����$!���" IP-�'������� 
����������� ethernet-���� ������� (ethernet switch). .������ �����  Update, ��������" 
���� Ethernet Port – Update, � ������� �����  ��������� ����� ��'��( (Profile Name) � 
����-������� ����� (Equipment).  
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20.10.2004  

 

���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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��������(� �������� LA5052 ������"$� ��'����� � ������#���$ ethernet-�������, 
���� ��������(�� � ���� Port Configuration ��� 900/901/902 (ethernet-����( �� CDG 1), 
910/911/912 (ethernet-����( �� CDG 2), 920/921/922 (ethernet-����( �� CDG 3) � 
930/931/932 (ethernet-����( �� CDG 4). Ethernet-����� 902/912/922/932 �� 
�	
��������
���� � ����� � ��
, ��� ��� ���	��������� 	�� 

��������������� ����
�	�������, � 	�� ��� 
�� ���	��� �������� �� 


������� . ��� ����������: x.eth3, �	� x ���	�������� ����� ��
�� �����, 
����	� �� ����, �� ����� ����� CDG  �� ����	����. �� 
���� 
�	
������������� ������ � ��
 ��
���, ���� 	�� �������� � 
��������� 

�	
��
 MLC �������
���� ���	������ PPP. � ���
 ��
��� �
 �
��� 
����	����� IP-�	���� � ������������ � �������
. *���( 900/910/920/930 
���������!��( ��" ���������" � IP-����$ (IP-�'�����() � �) � ��� ������� x.eth1. 
*���( 901/921 ���������!��( ��" ���������" �  ���� MN, �) � ��� ������� x.eth2. 
*���( 911/931 "��"$��" � '��������(�� �������, � ��� ���� �� ������� $��", 
�������" �� ��� �) ����� ������ � ����������������. *��������� �������� ������� 
����� ���� ����� � ��'��#� Ethernet Inetrface. &��� $-�� ����� "��"���" ��'������� 
���%�� ��������� �('����() ������. +('����� Signalling -> Ethernet Interface, 
��������" ���� Ethernet Interface.  
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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��" '���� ����"����� ������������" � ������ ����  �� ���'�����( ��� �������(� 
������(� ethernet-�����%���(. ���� � '��������(� ��� �� ��������$ ����-��, �� 
�����  ��������� ������ ethernet-�����%����� (����( 911/931 �� ���$� ������!����� 
��������), �����(� ���')����� ����� ���� ������ � ���� ����. *���(� !��(�� ethernet-
�����%����  �� ������( ��  ���!���$ � �� ���%�� ��� $��". 4�� ��"���� � ���, !�� 
��� ���������!��( ����$!������� ��" �������������" �������() ���� CDG. .� ���. 2 
(&���� ����	
�
 �

�������� � MN ��� �
��
���� 
�������
� �

���) ��� 
�'����!��( ��� �����%���( eth3, �� -�����"$-�� ������#�������� ��������������. 
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20.10.2004  

 

���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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��" ����� ���() ethernet-�����%����� ������� ������  Insert, ����� !��� ��������" 
����� ���� Ethernet Interface – Insert. +������ ���"����(� ����� �����%���� (Ethernet 
Interface), ��" �����%���� (Name), ���� (Port) � ��� ���������������� �����"��� 
(Administrative State). + ���� Ethernet Tagging & VLAN �� ���� ��� ������� ����(� ���) 
������, ��� ��� �������� �� ��� ��� ����.  

 

             
 

*���� ����, ���  ' ��� �('��� ���� (Port), ��� ����� (Type)  ���������" ��������!����, 
��� ���� ������������ ���!����. *���(, ���������!���(� ��" �������������" � MN, 
���$� �'����!���� «OAM», � ����(, ���������!���(� ��" �����$!���" IP-�'�������, 
�'����!�$��" «User Traffic». ���������������� �����"��� ��������!����  ���������" 
�� «On». +������(� ���!���" ���')����� ����������� ������� Apply. &��� $-�� 
����� "��"���" �����!���� IP-������� ����� �������(� ������. ,������� System 
Management � � ���$ Administration -> IP Network �('����� IP Address. 
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 

 
23/34 

Obr.:77-098a 
 

 
 
,�������" ���� IP Address.  
 

 
 
*�� ������� ������ Insert ��������" ���� ��" ����� I2-������� ����� �������() ������. 
 



 ��������� 
��	
������  

 

�: 
85/2004 

 

�����: 
���	� 	
��
� 

����: 
20.10.2004  

 

���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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��������: '�� ��#$� IP-�$���#� /%$+�� ���"��� +�1  � '#��#" x.eth2, ��# /1  �� 
��,�����+ �"% ��(�0 IP-�$���#� � "��(� subnet, (#�#�1�  /1 � /1  � #$�#. � �#. 
&�  '#$���� (subnet class), ��# � '#��1  x.eth1, ��( (�( '#�#" "#*%� '#����+�� 
'�#/ �"1  �# � 19�"#��+)  % IP-�/#����#�. 

 
*���� ����, ��� ' ��� �('���� ��" �����%���� (Ethernet Interface Name), ���� 
�('�����" ��������!����. +������ IP-����� � ����  subnet. + ��������� Metric 
 ��������� «1» � «Primary» ��" Function. + ���#� ������� ����(�  ��� MN. ,������� 
���� Administration -> IP Network -> MN Host. 
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���������� ����������� � ��������������� ����� ��� �����, � ����� ������!� ��� ���������" ������� ��#�� �� �������$��", ���� �� ��� 
��� ���������" � ���������� %����. &��.: 
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*�� ������� �� �����  Insert ��������" ����� ����, � ������� ������� IP-�����  ��� MN, 
��" hostname  ��� MN � ������� ��� ���������������� �����"��� (Active). +��� ����() 
����������� ������� Apply. 
 

 
 

3����� ���������  ��� � �����"��� In Use (Administration -> Node Data Status). *���� 
������������" ������� Apply � ������� Yes, � ����� ��� ����(��� ���� Node Data Status 
������� Close �����������" ������� RestartNet, �����(� �� ����!���$ ���#�� � 
�������������"  �������� ������ OK. 
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���� ���')�����  ��������� � �����"��� �����������" ����() (Administration -> DB 
Synchronisation), ��"�� �� ����� ������������" ���������) ��������, �����(� ��"�"��" 
�� ������. 

 

    
 

 
 

+�� ������ � �������"#�� ������������ �'����!���" � ������������() ����(). + ���� 
System Management �������� Administration -> Install – Backup. + ���� Install – Backup 
�('����� Actions -> File Transfer -> Install. + ���� Generic Version �('����� �����$ *,, 
������" ' ��� ���������������" ��  ���, � ���� Mode �('����� SW and Data, � ���� 
Data Version �('����� �������, �����(� '(� �(������ ��������� ����" ����� � � ���" 
Username � Password �'� ���� ������� sysadmin. ��" �������� ����, ��)�����" ��  ��� 
� �����"��� �������"#��, �('����� Actions -> Check State, ����� !��� �������� ������ 
Run ��!���� �������"#�$. ����   ��� � '���������" �������, �� ���!��� � ��� 
�������������� ������  A, ����� !��� ��������� �������"#�$ �� ������� B. 
0�������� ���" ������� �('������" � ���� Side Hostname. 
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�(�" #/��,#", ��#/0#$�"# ��)  '�#!�$%�% ��#$� %, �, �"'#����#����� 
� 8(�'#����#����� $���10 '#��#���+ �� ������� MN. �����  �!�� �� 
%, �, (#����#, /# +9� �� �%&�� �.(. #�� /1 � �# +(# ��# �$� ���. 
 

6. �
�	�5����
����� PPP-�
�������� ��� ��
������� 
�������
���
����� � �
�
�
��  

*�� ���%�� ��������� PPP-���������" � ��� ��� MLC, ���')����� �����$!����" � 
�����%����� x.eth3 �� �����!�() �����) CDG. 3��, ������ IP-������� �����%����� 
x.eth2 ���� CDG � %��� host, ������� �������������� ����%�� ��������(� IP-������ 
�����%����� x.eth3. .� ������ �)��� ���������� ������� ���� LAN � ��������(�� IP-
�������� ������ �� � -���� $-�) ��������: 
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6.1 �#$*#�#�(� $���10 �� "#$% � MLC 

.� MT � Configuration Management ���!��� ������� ���(� �����%��� ���� �� ��" PPP-
�������������" �� �����%���� V5.2. 
 

 
 

*�� ������� ������ Insert ��������" ���� Access Interface, � ������� ������� 
���"����(� ����� �����%���� (� ������ �� !�� 2) � ��� �����%���� (Access Interface 
Type). 
 

 IP: 192.168.38.90 

MN 

 
MCA MLC 

LA5052 
(duplicated) 

PPP1: 172.80.80.79 
PPP2: 172.80.80.80 

    
    CVx1-eth: 192.168.38.21 
    CVx2-eth: 192.168.38.22 
 
    NISM-int: 192.1.21.100 
    CDA08: 192.1.21.9 
 

 
    CDG1-eth3: 11.12.13.1 
    CDG3-eth3: 11.12.13.3 
 

 MPS 

PPP3: 193.7.10.17 

PPP4: 193.7.10.18 

 

L 
A 
N
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��" ����������� ����������������" �������� System Management ->  Administration -> 
IP Network -> PPP Conection � ������� Insert. 
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+ ���� Connection ������� ���"����(� ����� PPP-���������". + ���� Interface 
�('����� PPP-����������,  �������������� ����������� ������ E1 ��� �����%���� 
RS232 (� ������ �� !�� «CE1»). +������  ������(� ����� PPP (Remote IP Address) � 
�������(� IP-����� (Local IP Address). ,������(� ��������(  ��������� ���, ��� 
�������� �� ���)��� ��� ���. ���� PPP ���')�����  ��������� ����������� ������ E1, 
�� � ���� CE1 Interface, ����(������ ������� More, ���')����� ������ ���"����(� 
����� ������%������� CE1 (CE1 Identity), ��%���������� ��� ������ (Channel Type) � 
����������, �� ����� �����%���� V5.2 ���� PPP-����������, �� ����� ����  � �� ����� 
������. +�� ������ ����������� ����������� ������"�� ������ Apply. ���� � MLC 
�����$!���� ����� MPS !���� PPP-����������, �� ���')����� ������� ������ ����� 
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PPP, ��� ������ CE1 �('����� RS232. *�������� ����� ���� ���#�� �( "��"���" ���� 
�'������� ����� �� ������� MN � ����� �� ���������" ������� �� MPS � ������� A 
(CDG1) ��� ���')�������� ������$!���" �� ������  B (CDG3). 5���� � ��" ������� �� 
MPS � ��� ������ ����� , !�� � ������ �� !��  MPS %���!���� �����$!�� � ����  
RS232, ��)��"-�� �" �� ������ ����� CLC, � PPP-����� ��" MPS ������ ��������" � 
����  RS232, �� �����(� %���!���� �����$!�� ��'��� MPS. 4�� �������" � ���� + 
System Management -> Administration -> IP Network -> IP Route: 
 

 
 

.������ Insert , ��������" ���� IP Route – Insert. 
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+������ IP-����� ������� MN (Address),  ������(� ����� PPP-������ (Gateway), ����  
������� (Mask) � �������(� ����(�, ��� ��� �������� �� ��� ��� �(�� (Metric in Max. 
Packet Size). *��#�� �  ��������� � ��" ������� ����� ��. 
 
6.2 �#$*#�#�(� $���10 �� "#$% � MCA 

*�����������(� ���� %��� init_net ���������!�� ��" � '����������� LA5052. ����   
��� ��� '���������" �������, �� ����(�, ������(� � ���� ������� ��" � '���������� 
����( CLC/CDG, ������� �� � ���. + ����������� ���� %���� init_net -��� ��� ������ � 
IP-������� 11.12.13.3. *���� ��!���� ������ ������ %���� init_net ��������� 
�������(� ������( ��� �" MCA, �������  ���')����� ��'����� ���(� AN. &� ����#�� 
(MCA) ����������� ���#�� �( Backup SPD � Backup Specific SW. & -���� $-�� %��� 
init_net ���������" C:\si2000\install\sn\SNexchid\A_SIDE\etc ��)������ ��� �����-��'� 
�� ��� ������ (��������, init_net.old) � �� ���� ���������� ������ ��� ���(� %��� 
init_net, �������-�� ���')����(� ������ ��" ������ AN. .�  ��� MN ��� �� ��������� 
53 ����������� %��� init_net � ��� � !���� ����� ��������������� � %��� ��� 
����������� ���� IP routing � ��������� ��� �� �'� ������( MCA, ����� !��� �������� 
������$!���� (reset �������� ������( MCA). +(������ ����(� ��" ������%������� 
PPP-������ ��" ��'���"����� ��� �". 

 
CVA: rip enable 
CVA: route add host 193.7.10.18 192.1.21.9 <1#"* % �)/ MPS (0 #$�!- * $# CDA08> 
CVA: route add host 11.12.13.1 192.1.21.9 < 1#"* % �)/ MLC/A (0 #$�!- * $# CDA08> 
CVA: route add host 11.12.13.3 192.1.21.9 < 1#"* % �)/ MLC/B (0 #$�!- * $# CDA08> 
CVA: route add host 172.80.80.80 192.1.21.9 <(0 #$�!"# (�#)*$$��� PPP $# CDA08> 
CDA8: add_ni ppp 172.80.80.79 172.80.80.80 id 1 std <� "4% -* "#$#)# PPP > 
CDA8: route add host 193.7.10.18 172.80.80.80 < 1#"* % �)/ MPS (0 #$�!- * $# PPP> 
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CDA8: route add host 11.12.13.1 172.80.80.80 < 1#"* % �)/ MLC/A (0 #$�!- * $# PPP> 
CDA8: route add host 11.12.13.3 172.80.80.80 < 1#"* % �)/ MLC/B (0 #$�!- * $# PPP> 
CDA8: route add host 192.168.38.90 192.1.21.100 <�.4# $%3 '#464(  �)/ 1#"* �! MN> 
 

  
���"����: ��&�� '���� +�1. '#��$#( ���#(, ,�'�����10 � -�. � init_net! 
 
 

 
 
*�����������(� %��� init_net ���������� ��  ���. 4�� �(����"���" ������������ � 
�������"#��� ������������ ������ � ����(). 4�� ����� ������� ����� � ����-�$ 
���$ File -> Transfer, � ���� �������� ������� ������ ��  ���!���$ psos � �������� Put 
��������� %��� init_net ��  ���. ��" ����, !�� '( %��� ��!�� ��'�����, � ��� 
���������� �������� ��  (reset)  ���. 
 
6.3 �#$( )����� (�/� � $ �  #/��'������ �,��"#$�.����� � MPS �� MLC 

.� MLC ���� ���� ����#����(� ���� ��" MPS, ������ �� �!��  (�.�. �������) �� ����� 
CLC. 
 ������� , ��)��"-�� �" ��������������� �� ���#������ CDG, ��'��� ��" 
��'��( � MPS �����$!��� ����������. 
 
6.4 �#$*#�#�(� $���10 �� ������� MN  

��" ����������� % ��#����������" PPP-���������" ���')����� �� MN � ����-�$ 
Command Prompt (cmd) ������ ���� $-�� ������(, '�������" �����(� �� MN ' � � 
��'�����( ������������(� ����� �(: 
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C:\>route add –p 11.12.13.1 mask 255.255.255.255 192.168.38.22  
C:\>route add –p 11.12.13.3 mask 255.255.255.255 192.168.38.22 
C:\>route add –p 193.7.10.18 mask 255.255.255.255 192.168.38.22 
C:\>route add –p 172.80.80.80 mask 255.255.255.255 192.168.38.22 


